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midas FEA is state of the art software, which defines a new paradigm 

for advanced nonlinear and detail analysis of civil structures. With the 

experience in structural analysis software development since 1989, MIDAS IT 

delivers reliable solutions with utmost accuracy through the software.  

 

In addition to exceptional analysis performance, midas FEA is equipped 

with advanced geometric modeling functions, powerful mesh generation 

algorithms, various analysis conditions and exceptional output displays with the 

latest graphics technology.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

midas FEA Environment 

1.1 Introduction 

 



 

 

 

2 
 

 
 

 
 

2
. 
In

s
ta

ll
a
ti

o
n

 

 

        2. Installation 

m
id

a
s
 F

E
A

 



 

 

 

We Analyze and Design the Future 
We Analyze and Design the Future 

nalyze and Design the Future 

Ⅰ-2-1 

 

 

 

 

 

 

midas FEA operates on IBM compatible Personal Computer (PC) in the 

Windows environment. 

 

In addition, midas FEA requires the following minimum configuration. 

  

 

Operating 

System 

Microsoft Windows 2000 / ME / XP / Vista 

NT 4.0 SP3 + Y2K Patches 

(Microsoft Windows 2000 or later version 

recommended) 

MS Internet Explorer 6.0 or higher 

 

CPU Pentium III 700MHz 

(Pentium IV 1 GHz or greater recommended) 

 

Memory (RAM) 256 MB  

(512 MB or greater recommended) 

 

HDD Space 1 GB 

 

Video Memory 32 MB or greater 

 

Video Card TNT/GeForce Type Videocard recommended 

Windows XP / 2000 (30.82 Version or later)  

 http://www.nvidia.com/view.asp?IO=winxp-

2k_30.82 

Windows NT ( 29.42 Version or later) 

 http://www.nvidia.com/view.asp?IO=winnt_29.42  

 

Printer Windows compatible Printer or Plotter 

2.1 System Requirement 

 

http://www.nvidia.com/view.asp?IO=winxp-2k_30.82
http://www.nvidia.com/view.asp?IO=winxp-2k_30.82
http://www.nvidia.com/view.asp?IO=winnt_29.42
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Follow the steps below to install midas FEA. 

 

 

1. Insert the midas FEA CD in the CD-ROM drive. 

 

2. If the Shift key is not pressed when the CD is inserted, installation will 

proceed automatically, and the midas FEA CD will process 

automatically. Select English for the setup language and click 

 button.  

 

 

 

 

 

 

 

 

 

midas FEA Choose Setup Language Dialog Box 

 

If the installation does not proceed automatically, select the Run 

command in the Start menu of Windows. Once the CD-ROM drive is 

assigned, enter the following command: 

                      D:\Install\Setup 

         (Note: This applies in case the CD-ROM drive is assigned to the 

directory D) 

         Click  to start the installation of the program. 

 

 

 

 

2.2 Installation Sequence - midas FEA 
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3. Once the installation program is initiated, the dialog box shown below 

appears, and the installation of midas FEA begins. The installation will 

proceed step-by-step to the subsequent phases following the 

displayed information. To proceed to the next step, click . 

To return to the previous step, click . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

midas FEA Installation Dialog Box 

 

4. When the license agreement dialog box is displayed, read the 

agreement carefully. If you agree with the agreement, check on “I 

accept the terms of the license agreement”. Click , and 

the installation will continue. 

 

5. Enter the user‟s registration information and click . 

 

6. The “Choose Destination Location” dialog box will appear. Select the 

folder in which midas FEA will be installed. midas FEA will be 

installed in the default folder by clicking . To change the 

folder, click  and select a folder to install midas FEA. 
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7. The “Select Feature” dialog box will appear. To select all the features, 

click  and proceed. If not, uncheck unnecessary features, 

and click . 

 

8. To return to the previous step, click  . To start the 

installation, click . 

 

9. When the lock driver is installed, midas FEA installation will be 

completed. 
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The Sentinel Driver is used to drive the Lock key of the Sentinel 

hardware. To run midas FEA and the Lock key, the driver has to be installed. 

The Sentinel Driver is installed automatically during the installation process of 

midas FEA. For upgrading or replacing a damaged Lock driver, follow the 

procedure outlined below. 

 

 To install the Sentinel Driver manually follow these steps. 

 

1. Press the Shift key on the left side of the keyboard and insert the 

MIDAS/Civil CD in the CD-ROM drive.  

 

2. Select the Run command in the Start menu. Once the CD-ROM drive 

is assigned, enter the following command: 

 

          D:\Install\protection drivers\setup 

    (Note: This applies in case the CD-ROM drive is assigned to the directory D) 

 

 

 

 To uninstall the Sentinel Driver follow these steps.  

 

1. Press the Shift key on the left side of the keyboard and insert the 

MIDAS/Civil CD in the CD-ROM drive.  

2. Select the Run command in the Start menu. Once the CD-ROM drive 

is assigned, enter the following command: 

 

          D:\Install\Protection Drivers\SSD5410-32bit.exe 

    (Note: This applies in case the CD-ROM drive is assigned to the directory D) 

 

3. In the Program Maintenance dialog box, select “Remove” to start 

uninstalling the lock driver. 

 

2.3 Installation Sentinel/Pro Driver 
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Program Maintenance Dialog Box 
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To operate midas FEA properly, register the serial number after 

connecting the protection key to the USB port. 

 

 

1. Connect the Protection Key to the USB Port. 

 

2. Execute midas FEA. 

 

3. The Register Protection Key is located in the Help command of the 

Main Menu. 

 

4. Select Register Protection Key in the Help menu. 

 

5. Enter the Protection Key ID provided in the Program CD Case in the 

Protection Key field. 

 

6. Select „Stand-alone‟ in Key Type. 

 

7. Click . 

 

 

 

 

Register Protection Key Dialog Box

2.4 Registering the Protection Key 
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3.1.1 Work Sequence of midas FEA 

 

General work sequence of midas FEA is as follows: 

 

A. Geometry Modeling 

B. Mesh Generation 

C. Analysis Condition 

D. Analysis 

E. Post-processing and Result Evaluation 

 

 

A. Geometry Modeling 

 

Generating a geometric model is the foundation for completing a finite 

element analysis model in midas FEA. Based on the geometry data, mesh 

generation and other additional modeling processes will ensue. The geometry 

model can be generated directly in midas FEA using its own modeling functions. 

In addition, midas FEA provides the data exchange capability, which enables 

import of a geometry data file created by other Computer Aided Design (CAD) 

software. 

 

When a geometry data file is imported from another program, it often 

requires some special operations such as simplifying shapes, healing damaged 

geometry or cleaning-up disordered shapes in order to create a quality analysis 

model.   

 

  

3.1 Before Getting Started 
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Solid Model of PSC Bridge with Internal Tendons 

Solid Model of PSC Girder with Internal Tendons 

Solid Model of Pylon Shell Model of Pipe Joint 
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B. Mesh Generation 

 

Mesh is generated on a previously created geometry model. Generally, 

hexahedron elements or quadrilateral elements are recommended for meshing 

to attain accuracy in analysis results. However, for a complex model, it is 

reasonable to use tetrahedron elements or triangular elements produced by the 

Auto-mesh generation function provided by midas FEA. 

 

For best possible mesh quality, midas FEA provides various mesh 

control functions and 3 different mesh generation methods; Auto-mesh, 

Mapped-mesh and Protrude-mesh. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Auto-mesh Generated with Surface Quad-dominant 

Mesh 

 

Mapped-mesh Generated with Surface Quad Mesh 

 

Mapped-mesh Generated with Solid Hexa Mesh 

 

Auto-mesh Generated with Solid Tetra Mesh 
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C. Analysis Condition 

 

midas FEA provides a variety of materials, physical properties, load 

types and boundary conditions. The load and boundary conditions can be 

applied not only to nodes and elements, but can be also directly applied to 

geometric shapes. Such capability is very effective when a model contains very 

complex shapes. 

 

Taking advantages of the Windows based GUI environment, midas FEA 

maximizes the simulation capability to display the load and boundary conditions 

in a practical manner. As a result, the simulation function significantly reduces 

data input errors potentially committed by the user. All loads and boundary 

conditions can be created and modified from the GUI as well as from an MS-

Excel compatible table.   

 

 

 

 

 

 

 

 

 

 

 

 

 

D. Analysis 

 

Once the generated model is completed with proper analysis conditions, 

the analysis model can be analyzed. During the analysis, a variety of 

information such as progress and error messages is shown in the Output 

Window.  

 

 

 

 

Example of Applying Non-uniform Pressure Load Example of Applying Boundary Condition Using 

the Cylindrical Coordinate System 
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Based on the finite element method, midas FEA provides various 

analysis features such as Linear Static Analysis, Eigenvalue Analysis, Buckling 

Analysis, Time History Analysis, Response Spectrum Analysis, Material 

Nonlinear Analysis, Geometry Nonlinear Analysis, Concrete Cracking Analysis, 

Fatigue Analysis, Linear/Nonlinear Heat Transfer Analysis and Construction 

Stage Analysis.  

In addition, midas FEA is equipped with a Multi-frontal Gaussian Sparse 

Solver and an Iterative Solver, which are known for prominent analysis speed in 

large models.   

  

 

E. Post-processing and Result Evaluation 

 

Once the analysis is completed properly, midas FEA will organize and 

provide the post data results for design process. midas FEA offers numerous 

outstanding graphical result displays including the facility for creating high 

quality animations. In addition, all the tables provided in midas FEA allow the 

user to view the analysis results at a glance, and they are compatible with MS-

Excel. The revolutionary post-processing capability of midas FEA will thus 

define a new standard for post-processors in the Computer Aided Engineering 

(CAE) industry.  

 

In addition, using the Report Summary function, all modeling and result 

data will be organized into a practical report so that the user can maximize 

efficiency for his work. 
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Example of Various Post Processing features of midas FEA 

Contour Plot 

Result Table 

Graph 

Iso-surface Plot 

Various Visualizations 
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3.1.2 Modeling Process of midas FEA 

 

midas FEA allows the user to create highly sophisticated geometrical 

data and generate mesh with any dimension or shape. Especially due to its 

advanced geometry modeling tools and high-performance auto-meshing 

functions, the user can model a complex shape much quickly and simply 

compared to traditional modeling programs, which mostly pertain to manual 

node and element generation methods. 

 

In this chapter, the geometry modeling and mesh generation will be 

discussed in detail. 

 

 

 

A. Geometry Modeling 

 

A geometry model is fundamentally formed by the interlocking 

relationship of various geometric entities. The geometric entities in midas FEA 

are listed in the following table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Filtering enables us 

to select shapes by 

geometry types. 
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Entity Definition 

Compound Group of independent entities 

Shape 
General term to call an independent entity 

(An entity that is not forming any other entity) 

Solid 
Part of 3-D space bound by a shell 

Property Volume 

Surface 

Shell 
A collection of Faces connected by some of the 

Edges of their Wire boundaries 

Face 

Part of a plane (in 2-D geometry) or a surface (in  

3-D geometry) bounded by a closed Wire 

e.g. Plane surface, cylinder, sphere, etc.  

Property Area 

 

 

Curve 

Wire A sequence of Edges connected by their Vertices 

Edge 

A shape corresponding to a curve bound by a 

Vertex at each extremity 

e.g. Straight line, circle, ellipse, arc, etc. 

Property Length 

Vertex 

A zero-dimensional shape corresponding to a point 

in geometry 

Property Coordinate 

 

 

 

 

 

 

 

Higher 

Level 

Entity 

Lower 

Level 

Entity 
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Extruding an Edge 

creates a Face. 

Extruding a Wire 

creates a Shell. This 

Shell shares the same 

sub-Shapes with a 

group of Faces,  

which is generated by 

the extrusion of the 

original Wire’s sub-

Edges.  

 

The user may 

interchange freely 

between closed Wire 

and Face or between 

closed Shell and 

Solid because they 

share the same sub-

Shapes. 

Compound is 

generally used to 

sort shapes easily. 

(i.e. grouping 

hundreds of Curves 

imported from 

Autocad’s .dxf file 

into a single 

Compound.) 

Vertex in 3-dimensional space 

1 Edge bound by 2 Vertices 

1 Wire connected by 

4 Edges 

1 Face limited by 1 closed Wire 

(4 Edges)


 

1 Shell connected by 6 Faces


 

(empty) 

1 Solid bounded by 1 closed Shell 

(filled) 

Face is a Shape, which 

exists independently   

A Wire and 4 Edges cannot be a Shape 

because they are sub-Shapes of a Face 

A Compound, which is grouped by 4 independent 

Shapes


  

(compound no longer exists as a shape) 

The boundary of a 

Face consists of one 

Wire, and the 

boundary of a Solid 

consists of one Shell. 
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The following examples will help us understand the topology more 

comprehensively. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Highest Shape One  (Face) 

Sub-

Shape 

Wire 
One  (Face‟s Boundary) 

 Group of E1 through E5 

Edge Five  (E1~E5) 

Vertex Five  (V1~V5) 

Highest Shape One  (Face) 

Sub-

Shape 

Wire 
Two  (Inner/outer boundary) 

 same as E1, E2 

Edge Two  (E1, E2) 

Vertex 

Two  (V1, V2) 

 Starting and ending points 

of edges


 

Highest Shape One  (Shell) 

Sub-

Shape 

Face Two  (F1, F2) 

Wire 
Two  (Boundary of each 

face) 

Edge 
Seven (E1~ E7) 

 They share E4
 

 

Vertex Six 

Highest Shape One  (Solid) 

Sub-

Shape 

Shell One  (Solid‟s Boundary) 

Face Six 

Wire Six  (Boundary of each face) 

Edge 

Twelve 

 4 for each face, 12 edges 

are shared 

Vertex Eight 

When the user sews 

two neighboring 

Faces into a Shell, 

one or more Edge(s) 

will be shared 

between Faces. In the 

diagram, two 

independent Faces 

have a total of 8 

edges, but the 

combined Shape, a 

Shell, has only 7 

edges. 

V3 

Face 

V1 

V2 

V4 

V5 

E1 

E2 

E3 

E4 

E5 

V1 V2 

E1, W1 
E2, W2 

Face 

No matter how many 

edges exist, a 

boundary of a Face 

will be always 

regarded as a Wire. 

In a closed Edge like 

a circle, starting and 

ending vertices are 

identical. 

F1 F2 

E1 

E2 

E3 

E4 

E5 

E6 

E7 

Shell 

Topology means the 

relationship of 

geometric entities. 

 

F1 

F2 

Shell (F:2, W:3, E:8) 

Solid 
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midas FEA provides both Top-down Modeling and Bottom-up 

Modeling methods.  Therefore, the user can choose either method or a 

combination of both depending on the beneficial characteristics of a particular 

model.  

 

 Top-down Modeling Method 

In this method, the user makes the highest level Shape, and its sub-Shapes will 

be automatically formed. The user does not need to waste a lot of effort to model 

each sub-Shapes. The method is often used for a simply shaped model or for a 

preliminary design process. 

i.e. If a cube is created with the primitive box feature of midas FEA, all sub-

Shapes of this solid such as Faces, Wires and Edges are automatically generated. 

 

 Bottom-up Modeling Method 

In this method, the user starts to model from the lowest level entities first. With 

these independently generated sub-Shapes, the final shape is assembled 

together. The operation may take a lot longer time than the Top-down method. 

However, by this method, the user can generate a very complex shape, which 

cannot be readily created by the other method. In most geometry modeling, the 

Bottom-up Modeling Method is widely used in practice. 

i.e. A 3D curved surface is extremely difficult to model directly at once. Therefore, 

Vertices and Edges, which represent the Face, will be created first, and the Face 

will be generated by using those Vertices and Edges. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3D Surface Generation with the NURBS Face  

(Bottom-up Modeling: EdgeFace) 

A Box Creation by the Primitive Box Function  

(Top-down Modeling: Solid) 
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The actual modeling process of the Bottom-up Modeling is shown 

below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Flow Chart of Geometry Modeling Process of midas FEA


 

 

  

It is not necessary 

to start modeling 

from the Vertex for 

the Bottom-up 

Modeling Method. 

If possible, the mid-

steps between the 

bottom shape and 

the top shape can 

be eliminated. 

 

--- --- --- : Possible Starting Points : Modeling Process : Completion 

Modify Edge/Wire 

Modify Face/Shell 

Modify Solid 

Mesh Generation 

Create Vertex 

Create Edge/Wire 

Create Face/Shell 

Create Solid 

Import Geometry Data File 

Modify Geometry Data 
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B. Mesh Generation 

 

midas FEA provides various types of elements. Each element type i

s defined by the structural characteristic of its associated nodes.
 

 

 

 Scalar Element 

It consists of 1 or 2 node(s), and it does not have a geometrical characteristic. 

Mass, damper and spring elements fit into this category.  

 

 

 

 

 

 

 1D Element (Line)  

A 1-dimensional element has a geometrical characteristic of length and consists 

of 2 or 3 nodes. Truss and beam elements fall under this category. 

 

 

 

 

 

 2D Element (Plane)  

A 2-dimensional element, which represents either a triangular or a quadrilateral 

element, has the geometrical characteristic of area. Plane Stress Element, Plain 

Strain Element, Axisymmetric Element and Plate Element belong to the 2D 

Element type. 

 

 

 

 

 

 

 3D Element (Solid)  

A 3-dimensional element such as Tetrahedron, Pentahedron (Wedge or Prism) 

and Hexahedron (Brick) has the geometrical characteristic of volume. 

 

Element types are 

categorized by their 

geometrical 

characteristics, and 

the structural 

behaviors of 

elements may be 

different within the 

same type. (e.g. 

Truss and Beam) The 

structural behaviors 

can be found in the 

Analysis Reference 

Manual. 

1-Node Scalar 

(e.g. Node Spring) 

2-Node Scalar 

(e.g. Element Spring) 

0

1

1st Order Line 2nd Order Line 

0

1
0

1

2

Triangular (1st, 2nd Order) Quadrilateral (1st, 2nd Order) 

0

1

2

0

1

2

3

4

5

6

7

10

2 3

0

1

2

3

4

5
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 Miscellaneous  

A few element types such as Rigid Links are categorized here. 

 

A structure in real life always exists in space, and it can be modeled by 

certain types of elements with proper dimensions. Its structural behavior can be 

expressed by an accurate material model with the corresponding geometric 

property. In order to construct an analytical model of a structure, its elements 

must include these 3 important characteristics; (a) nodal connectivity, (b) 

material property and (c) additional geometric property such as thickness. 

 

The geometric properties, which need to be defined for each of 1D, 2D 

and 3D elements, are listed in the table below.


  

 

Element 

Type 

Geometric 

Characteristic 
Property 

Volume 

Calculation 

1D Length(L) Area L  A 

2D Area(A) Thickness A  t 

3D Volume(V) N/A V 

 

 

 

 

 

 

0
1

2
3

4

5

6
7

0
1

3

4

5

6
7

2

8

9

10

11

12

13

14

15

16

17

18

19

0

1

2

3

4

5

0

1

2

3

4

5

6

7

8

9

10
11

12
13

2

0

1

3

2

0

1

3

4

5

6

7
8

9

Tetrahedron (1st , 2nd Order) Pentahedron (1st , 2nd Order) 

Hexahedron (1st , 2nd Order) 

The table to the 

right is intended 

for understanding 

the basics of the 

geometric 

property. The list 

only contains the 

common items. 

Depending on its 

structural 

behavior, each 

element type may 

require additional 

properties. For 

detailed 

information, refer 

to On-Line 

Manual. 
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        Regardless of dimension and type, the general process of mesh 

generation is shown in the following diagram: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General Process of Mesh Generation 

 

The detailed generation processes for each of 1D, 2D and 3D Mesh are 

as follows:  

 

 1D Mesh 

One dimensional elements are generated on the selected edges based on the 

specified mesh size. 

 

 2D Mesh 

Before generating 2D mesh, 1D mesh is produced on the boundary edges. The 

program executes this automatically in a hidden process. Subsequently, 2D mesh 

fills in the internal area, which is bounded by the previously generated 1D mesh. 

The 2D meshing algorithm can be specified either by the user or automatically by 

the program. 

 

④ Generate 3D mesh in the 

internal space 

① Select the object shape and 

specify the element type.  

② Create 1D mesh on all 

boundary edges. 

③ Create 2D mesh on all 

boundary faces. 

Complete 

1D Mesh 

Complete 

2D Mesh 

2D Mesh Generation 

Choose Mesh Algorithm 

Specify Mesh Size 
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 3D Mesh 

After generating 1D and 2D mesh, the program generates 3D elements in the 

internal space, which is enclosed by the 2D boundary mesh. If necessary, 1D and 

2D mesh generations are processed internally by the program. 

 

The user must use caution for the listed items prior to mesh generation. 

 

1. In order to generate a proper 2D mesh, 1D mesh on the boundary edges 

must be completely enclosed.
 
Similarly, in order to generate a proper 3D 

mesh, the boundary 2D mesh must be completely enclosed. 

 

2. For convenience, midas FEA permits size control on various geometry types 

such as Solid, Face and Edge. Yet, the predominant factor for determining 

mesh size is what is given on the Edges. Therefore, in order to mesh with 

desired size properly, it is recommended that the mesh size on the critical 

edges be specified first. 

 

3. Once a lower dimensional mesh is created manually, a higher dimensional 

mesh can be generated automatically based on the lower dimensional mesh.  

i.e. If a boundary 2D mesh is created, 3D mesh can be generated directly with it. 

Therefore, in theory, what is required to generate a 3D mesh is a boundary 2D mesh, 

not a Solid (Geometry). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Boundary mesh 

errors can occur 

more likely during 

3D mesh generation.  
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Valence


 is the number of elements, which share a single internal node. 

Depending on the Valence, the mesh can be divided into two groups, structured 

mesh and unstructured mesh.  

 

 Structured Mesh  

In the structured mesh, the Valence of internal nodes is constant. 

The Map Mesh function in midas FEA generates the structured mesh type in both 

2D and 3D.  

 

 Unstructured Mesh 

In the unstructured mesh, internal nodes have different Valences. 

The Auto Mesh function in midas FEA generates unstructured mesh with various 

auto-meshing algorithms. 

 

The following figures will help us understand the definition of the 

Valence and the difference between the structured mesh and the unstructured 

mesh by using 2D mesh sets.  

 

 

 

 

 

 

 

 

 

 

 

      In the structured mesh of the above figure, all internal nodes have a 

Valence of 4, and each node is equally shared by 4 elements. Each element will 

have a corner angle of about 90 (360/4). Such elements with close to a 90 

corner angle result in excellent element quality. However, the internal nodes in 

the unstructured mesh may have different Valences such as 3 and 5, and the 

adjoining elements at each node will have a corner angle of about 120 and 72 

(360/) respectively. As the Valence deviates from 4, the element quality thus 

deteriorates.


 

Valence is also 

known as “Degree 

of Regularity” or in 

short “Regularity.” 

The Valence of 4 is 

ideal in generating 

2D Quadrilateral 

Mesh (Structured 

Mesh). Whenever 

possible, the Valence 

between 3 and 5 is 

recommended. 

=4 
=3 

=5 

=4 

Structured Mesh Unstructured Mesh 
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Structured mesh renders excellent mesh quality, but there are a few 

trade-offs. The following diagram shows the general process of generating 

structured mesh, and the required conditions for generating structured mesh 

are indicated.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Process of generating Structured Mesh


 

 

After transforming the actual 3D geometry into the 2D base geometry, 

quadrilateral elements thus fill in the internal area of the base geometry. Again, 

the generated quadrilateral mesh is mapped back to the original geometry. Due 

to the complicated nature of this method, the original 3D geometry must satisfy 

the following two conditions. 

 

 

 

 

 

This type of 

structured mesh 

generation is known 

as “Mapped Mesh.” 

The shape of the 

base geometry of 2D 

structured mesh is 

rectangular. 

Similarly, for the 3D 

structured mesh, a 

cube becomes the 

shape of the base 

geometry. 

1 0  

 

Inverse 

Mapping Mapping 

x 

y z 

2D Base Geometry  

(By the Grid Method) 

② 

③ 

① ③ 

④-1 

x 

y z 

Inverse 

Mapping 

Mapping 
3D Original Geometry 

④-2 

3D Original 

Geometry 

① 

② ④ 

③ 

1 
① 

④ 

② 
④-3 
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1. In order to form the base geometry, 4 corner vertices must be defined.


 

 

 In case of convex polygons, midas FEA automatically detects the 4 corner 

vertices. Moreover, it also provides the user an option to define the 4 

vertices manually. If 4 vertices cannot be defined, the geometry shape must 

be divided into applicable shapes as shown in the examples below. 

 

 

 

 

 

 

2. The number of nodal divisions on an edge or an edge group must match the 

coupled edge or the coupled edge group (①-③, ②-④). 

It is recommended that the Number of Divisions be applied for the mesh 

size control rather than the Interval Length for constructing a structural 

mesh, in order to maintain the same number of mesh divisions on each side. 

 

Unlike the structured mesh, the unstructured mesh can be applied to 

any shape of geometry without any limitations such as the number of divisions 

and the geometrical structure. Therefore, any complex geometry can be 

meshed with much less effort.
 

 

 

FEA provides the following 3 unstructured meshing algorithms: 

 

 Loop Mesher 

Loop Mesher generates quadrilateral mesh on an object shape directly using a 

looping method. Loop Mesher is able to accurately encompass the outline of the 

object shape. And it generates uniform size mesh regardless of curvature. 

Especially, when the length to width ratio of mesh is more than 2, it generates 

quadrilateral mesh with a very smooth transition. However, due to the 

characteristics of the algorithm, the resulting mesh tends to become less regular 

and perpendicular. If an internal vertex or edge is included, the mesh quality may 

become relatively poor compared to other meshers. 

 

 

Hence, unstructured 

mesh is referred to as 

Free Mesh. 

In a 3D structure, 

8 corner vertices 

must be defined. 
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 Grid Mesher 

Grid Mesher generates quadrilateral elements within a domain by using a base 

grid. And it connects internal mesh to boundaries using quadrilateral or triangular 

elements. This meshing algorithm is known to result in prominent quality in 

regularity and orthogonality. However, it exhibits a weakness when element size 

changes more than the ratio of 2 due to rough transitional characteristic between 

elements. 

 

      Grid Mesher can mesh with both quadrilateral and triangular mesh, and it 

is most suitable for domains that are likely to have similar mesh sizes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                          Meshing process for Loop Mesher 

 

 

 

 

 

 

 

Looping Algorithm is 

only applicable to 

simply-connected 

areas. 

Meshing area Create boundary mesh Divide into simple domains 

by connecting boundaries


 

Create Pattern Mesh on each 

loop and smooth elements 

Recursive division into 6-8 node 

elements by sub-looping 
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Meshing process for Grid Mesher 

 

 

 Delaunay Mesher 

Delaunay Mesher is one of the most popular meshing algorithms. It exhibits 

excellent performance in triangular mesh generation. Especially, internal vertices 

and curves can be freely included in mesh generation. 

 

Proper selection of element types and the quality of element shapes 

affect the analysis results to a large extent. Therefore, it is very important to 

choose proper element types and shapes and check the nodal connectivity 

between the elements in order to obtain accurate results.  

 

The following list introduces the essential information required before 

mesh generation: 

 

1. As the element shapes become closer to regular polygons and regular 

polyhedrons, the analysis results become much more accurate. 

 

2. The analysis time is a factor that should not be ignored during modeling. 

Therefore, it is important to keep the number of elements within a 

reasonable range. Careful planning of element distribution can prevent a 

massive model size. Fine mesh should be considered in the following cases;  

Create a grid on the object Delete element around boundary and 

internal object and create mesh 

Lack of space to 

grade mesh size 

Perpendicular mesh 

due to base grid. 
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(a) where the analysis is of a critical type, (b) where the geometry radically 

changes, (c) where the material or the property changes, (d) where the load 

varies, and (e) where critical results are expected. Coarse mesh can be then 

used for the balance area since the analysis results may not be very 

sensitive to mesh sizes. 

 

 

 

 

 

 

 

 

 

 

 

 

Since triangular elements are relatively stiffer than quadrilateral 

elements, a model with quadrilateral elements is generally expected to 

produce better results. Similarly, hexahedral elements are preferred to 

tetrahedral elements.


 

Also first order elements are stiffer than second order elements. 

Therefore, it is recommended that second order elements be used, 

especially when a model is assembled with triangular and tetrahedral 

elements. 

 

3. Upon completion of mesh generation, the nodal connectivity between the 

generated elements must be checked. The separated nodes will cause free 

edges in 2D and free faces in 3D mesh.


 
 

 

 

 

 

 

 

 

However, good 

quality triangular or 

tetrahedral elements 

are better than poor 

quality quadrilateral 

or hexahedral 

elements. 

Free edge and free 

face can be checked 

by the “Check Mesh 

Function” of midas 

FEA 

Example of Mesh where finer elements are generated near connection  

(The selected element sizes should be such that a smooth transition is maintained) 

Linear Grading (1:4) Example 
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4. The mesh quality checking tools in midas FEA enable us to verify the 

feasibility of mesh shape in an analysis model. The user must mesh 

carefully in the area where the geometry radically changes because 

unacceptable elements may occur. In addition, Jacobian Ratio for 

quadrilateral elements must be checked to see whether or not non-convex 

quadrilateral elements exist. In addition, collapsed tetras, nearly flat 

elements, must be avoided. 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 

In midas FEA, the 

user can check mesh 

quality with various 

criteria. Detailed 

information on the 

mesh quality 

function is available 

in the On-line 

Manual. 

Example of Free Edge in 2D Mesh at the Beam and Column Connection 

Free Edges exist at 

connections 
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The Menu System of midas FEA permits an easy access to all the 

functions related to the entire process of input, output and analysis and 

minimizes mouse movements. 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

               Organization of Windows and Menu System 

 

 

 

Toolbar (Icon Menu) Main Menu 

Works Tree  

Property Window 

Work Window 

Output Window 

Tree 

Task Pane 

Table Window 

Tree 

Context  

Menu 

3.2 Organization of Window and Menu System 
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midas FEA consists of a total of 6 windows. 

 

 Work Window 

Work Window deals with modeling structures and interpreting analysis results by 

means of GUI (Graphic User Interface) of midas FEA. 

 

 

 Table Window 

Table Window displays all types of data entries and analysis results in a Spread 

Sheet format. Various types of data modification, additional input, compilation, 

arrangement for different characteristics and searching capabilities are provided 

in Table Windows. The tables are compatible with common database software or 

MS-Excel for data transfers. 

 

 Works Tree Window 

Works Tree stores all the data of the current project such as geometry, mesh, 

load, boundary condition, analysis control and analysis results. It organizes such 

data in a tree format, which is similar to Windows Explorer.  

 

 Property Window 

Property Window shows general information about each individual entity that the 

user selects from the Work Window or the Works Tree. Basic modification such as 

its name and color can be also made through the Property Window. 

Depending on the working mode (pre-processing or post-processing), the 

Property Window has a unique format and function.  

 

 Output Window 

Output Window displays all types of information necessary for modeling and 

warning and error messages. 

 

 Task Pane Window 

Task Pane Window provides “Step by Step” guidelines, which allow easy access 

to most frequently used analysis options and modeling functions. midas FEA 

provides a general Task Pane definition, and the user is also free to customize it 

to his preference. 
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midas FEA has the following menu system: 

 

 Main Menu 

The Main Menu has commands for all the built-in functions necessary to run 

midas FEA. 

 

 Toolbar (Icon Menu)  

The Icon Menu helps the user promptly invoke functions frequently used in midas 

FEA. Each icon is regrouped with the icons of similar purposes by Tab for easier 

recognition. 

 

 

 

 

Each Toolbar can be easily dragged with the mouse to a desired position on the 

screen. They may be edited to appear selectively on the screen or modified by 

using View>Toolbars>Customize. For more information on any icon in the 

Toolbar, place the mouse cursor on the icon in question and Tool Tip will provide a 

short description. 

 

 Context Menu 

In order to minimize the physical motions of the mouse, simply right click the mouse. 

midas FEA automatically brings a menu system, which offers related functions or 

frequently used functions reflecting the working circumstances of the user. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Curve Tab: The group of tools that are frequently used to create and modify curves 

It is better for the 

beginner of midas 

FEA to control the 

commands with the 

Main Menu to 

comprehend the 

program more 

thoroughly. However, 

once the user 

becomes familiar 

with the system, it is 

much more 

convenient to use the 

Icon Menu.  
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3.2.1 Work Window 

 

When the user starts midas FEA, only the Start Page will appear on the 

screen. When opening a new project, the user will see the Work Window where 

actual modeling will take place. 

 

The Start Page is a window that is hyperlinked to MIDAS IT 

Corporation‟s Homepage (http://www.MidasUser.com) and the User Support 

Center. 

 

       The Work Window deals with modeling and interpreting analysis results 

by means of GUI (Graphic User Interface) of midas FEA. 

 

       The display related options, including the modification of the 

background color, can be controlled in Main Menu > View > Display Option or     

Display Option icon in the Icon Menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The user can switch between the Start Page, Work Window and Table 

Window by clicking their Tabs. 

In Display Option, the user can change various 

display settings of the Work Window. 
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3.2.2 Works Tree Window 

 

midas FEA provides Pre-Works Tree and Post-Works Tree depending on 

working modes. 

 

 Pre-Works Tree 

The Pre-Works Tree is similarly structured to the Windows Explorer. It retains all 

pre-processing modeling information of geometry, mesh, load and boundary 

conditions. The user can also perform basic modeling operations using the Pre-

Works Tree such as Show/Hide objects.


 

The following are the featured functions of the Pre-Works Tree: 

 

1. The user can select objects from the Pre-Works Tree as well as from the 

Work Window.  

 

2. Depending on the selected entity, the Pre-Works Tree provides a 

customized Context Menu, which includes a range of practical operations 

such as the Show/Hide function. 

 

3. The Works Tree provides a working environment similar to the Microsoft 

Windows Explorer with which the user is familiar. The user will likely operate 

various functions intuitively such as Rename, Delete and Move in the Works 

Tree.


 

 

 

 

 

 

 

 

 

 

 

 

 

 

When dealing with a 

complex model, the 

user often 

encounters troubles 

in selecting and 

modifying entities 

from the Work 

Window. However, 

using Works Tree 

and Context Menu 

can help the user 

select and modify 

the entities much 

more easily and 

conveniently. Since 

Context Menu 

changes depending 

on the selected 

entity, the user is 

encouraged to try 

out each case 

individually. 

The user can 

learn more about 

its functions in 

the provided 

Tutorials. 
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Structure of Pre-Works Tree and Its Functions 

 

 

 Post-Works Tree 

Once the analysis is completed, the program automatically brings the post data 

and arranges it in a tree format.


 In the Post-Works Tree, the user can control 

most of the output results such as the graphic and table related displays. The 

user can also save the current display output.  

 

 

 

 

 

 

In other programs, 

the user must check 

the analysis results 

after careful 

interpretation. 

However, midas FEA 

organizes results in a 

tree format 

automatically, and 

the user can simply 

view the post data by 

simple mouse clicks. 

F2 Key: Rename 

Del Key: Delete 

Merging and 

Moving Mesh-

sets by simple 

Drag & Drop 

Customization of 

Context Menu by 

the Selected 

Object 

Structure of Pre-

Works Tree 

 Group [Number 

of Entities] 

Entity Name [ID]  

    

Modification of 

Property and 

Material 
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Structure of Post-Works Tree and Its Functions 

 

 

 

 

 

 

The contour plot can 

be drawn by double-

clicking on the 

relevant variable. 

Structure of Post-Works Tree 

 Analysis Step 

     Result Type 

       Result Data 

           

Table provides 

numerical results in  

a tabular format. 
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3.2.3 Property Window 

 

       The Property Window provides a set of information about the object that 

has been selected from the Work Window or the Works Tree. Depending on the 

actual working mode, the Property Window functions differently. Therefore, the 

Property Window will have a different structure for each mode (Pre-Processing 

and Post-Processing). 

 

 Pre-Processing Mode 

The Pre-Processing Mode displays general information on a selected object, and 

simple modification of basic properties such as name and color can be made in 

the Property Window. The structure of the Pre-Processing Property Window may 

change depending on the selected entity, but the general structure is shown in the 

following figure:


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The selection’s 

name and color can 

be changed in the 

Property Window. 
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       Example of displayed Information in Pre-Processing Property Window 

 

 

 Post-Processing Mode 

Unlike the information shown in the Pre-Processing Mode, the Property Window 

in the Post-Processing Mode is used to specify options for the post-processing 

operations.


  

 

Once an option is specified in the Property Window, it becomes applicable to all 

post processing operations. In addition, the program saves it into the registry so 

that the same option can be applied to other projects. 

 

 

In order to invoke 

the Property 

Window, only one 

single object must 

be selected. 

Post-options are 

specified in the 

Property Window, 

and post-

operations are 

controlled in the 

Icon Menu. 

Mesh Set 

Geometry 

Entity 

Mesh 

Material 

Property 

Name, Color,  

Shape Type, 

Geometric 

Characteristic 

Name, Type 

Color, Material 

Total Number of 

Nodes/Elements 

Name, Color 

Node/Element 
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Structure of the Property Window in the Post-Processing Mode 

 

 

 

3.2.4 Output Window 

 

The Output Window displays all types of information necessary for 

modeling and analysis, warning and error messages. 

 

The displayed messages in the Output Window can be copied to the 

Clip Board, and they can be used in other text programs. 

 

 

 

 

 

 

Example of Messages in Output Window and its Context Menu 

 

 

 

 

 

 

 

Selected Text 

can be copied. 

Detailed Options of 

Contour Plot 
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      While working with the Works Tree Window, the Property Window and 

the Output Window, there may be a need to hide or change their locations. 

 

 

Here, the basic operation of these 3 windows will be introduced. All the three 

windows have the main control buttons on the top right corner. Basically, all the 

operators are included in the Menu Button


 as shown in the figure, and for 

convenience, midas FEA provides additional individual buttons for most 

frequently used functions. 

 

 

 

 

 

 

 

 

 

 Floating  

The window can be located at any place in and out of the program. 

 

 Docking  

The window can be located only at a designated location such as Right/Left/ 

Top/Bottom. 

 

 Auto-Hide


 

The window will be hidden except for the title bar. When placing the mouse 

over the title bar, the entire window will appear again. 

 

 Hide  

The window will be completely hidden. The window‟s Show/Hide is 

controlled through the Window menu in the Main Menu. 

 

 

Operations of Works Tree/Property/Output Windows 

The menu button is 

available only in the 

VS.NET 2005 

format. The window 

style can be 

specified in Display 

Option (View > 

Display Option). 

Floating and 

Docking, which do 

not require specific 

buttons, can be 

controlled by 

dragging the 

mouse. 

Auto-Hide can be 

used only in the 

Docking mode. 

Auto-Hide 

Menu Button 

Hide 
Only Available in 

“VS.NET 2005” 
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To move the window location, hold down the left mouse button after 

clicking on the title bar and release it at a desired location.  

 

 To position a window in the Floating mode 

After dragging a window into an empty space, release the left mouse button. 

 

 To position a window in the Docking mode 

Dragging a window into the boundaries of the main frame or the inside of 

another window will set the window to the Docking mode. When the window 

is positioned in a desired docking location, release the mouse button to 

complete the operation. 

The easiest way to situate a window properly in the Docking mode is: 

 

1. Specify the window style as the VS.NET 2005 format in the General tab of 

Display Option (View > Display Option).


 

 

2. Click the title bar of the object window, and drag the mouse around. The 

docking position buttons will appear on the screen. The buttons will be 

structured differently depending on where it is dragged. 

 

The default 

window 

style is the 

VS.NET 

2005 format. 

Property Window 

 Floating Mode 
Works Tree Window 

 Left Docking Mode 

Output Window 

 Auto-Hide Mode (Bottom Docking) 
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3. Place the mouse pointer on the top of the desired docking position button. 

When the position is highlighted, release the mouse button to place the 

window in the Docking position. 

 

This method is very convenient when the user is trying to dock a window inside 

another window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example of Docking to Another Window  

(Drag the positioning window to another window) 

Example of Docking to Program’s Boundary 

(Drag the positioning window to Work Window) 

Locate the window 

location using the 

Docking buttons. 

The area to be 

positioned is 

previewed 

(highlighted). 

Drag it to the top of 

the button 

Release the mouse 

click to finish 
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3.2.5 Main Menu 

 

Main Menu includes commands and shortcut keys of all the functions 

that are required to operate midas FEA. 

 

 

 

 

File File, Print and Data Exchange  

Edit Undo/Redo 

Geometry Geometry Modeling Functions (Create/Modify), Work Plane and 

Grid 

Mesh Mesh Control / Mesh Generation (Auto, Map, Protrude) / Manual 

Operation  

Analysis Analysis Option / Analysis Control / Analysis Perform 

Post Result Combination / Extraction / Post File Conversion 

View Display Option / Show and Hide / Visualization Related 

Window Window‟s Active / Inactive / Arrangement 

Help On-line Help / Link to MIDAS IT Homepage / E-mail Contact 
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3.2.6 Toolbar and Icon Menu 

 

Icon Menu helps the user promptly invoke functions, which are 

frequently used in midas FEA. Each icon is regrouped with the icons of similar 

purposes in various Toolbars. Each Toolbar can be easily dragged with the 

mouse to a desired position on the screen. For further information on any icon in 

the Toolbar, place the mouse cursor on the icon in question and Tool Tip will 

provide a short description.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

          Configuration and Arrangement of Icon Menu  

 

 

 

File Undo/Redo Selection Work Plane Snap 

Function (Tabbed Toolbar) 
Zoom 

View Point 

Rotate (View) 

Dynamic View 

Display Mode 

Measure & Query 
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The Function Toolbar is one of the outstanding features in midas FEA. 

The Function Toolbar is designed in the tabbed toolbar format to maximize its 

usability. Therefore, even a novice can utilize the toolbar immediately. The 

commands are grouped together by their geometrical or functional types. For 

example, if the user wishes to make a planar surface, he can find relevant 

commands in the Surface Tab.  

 

Example: How to find an icon in the Function Toolbar?
  

 

To Create a polyline (which is a 

geometric type of Curve.) 

→ Curve Tab 

To Trim an object (which is a 

geometric type of Solid.) 

→ Solid Tab 

To delete a polyline or a solid → Geometry Tab (a group of commonly 

shared functions by multiple geometry 

types) 

 

 

 

 

 

 

 

       

   Example of Effective Use of the Function Toolbar 

 

The detailed information on the Toolbars and the Icon Menu of midas 

FEA can be found in the Appendix, “Toolbar & Icon Menu.” 

 

      The Toolbars can be placed in any desired area of the program, and they 

can be shown or hidden through Customize command in the Context Menu. In 

addition, the user can customize the Icon Menu so that they can create their 

own Icon Menu.
 

 

 

 

 

In the Command Tab 

of the Customize 

Toolbar dialog box, 

the user can edit the 

Toolbars by dragging 

icons in and out. 

The customized 

Toolbar can be 

initialized with Reset 

All button in the 

Toolbars Tab. 

After completing Solid operations in the Solid Tab in Icon Menu, 

Switch to the Auto/Map-Mesh Tab, and Generate Mesh on the Solid. 

Function Toolbar 

is most widely 

used Tool bar. 

Therefore, it is 

recommended that 

each icon be tried. 
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    Customization of Toolbar 

 

 

3.2.7 Context Menu 

 

In order to minimize the physical motions of the mouse, simply right click 

the mouse. midas FEA automatically selects a menu system, which offers 

related functions or frequently used functions reflecting the working 

circumstances of the user. 

 

Please refer to the Appendix for the detailed information on midas FEA‟s 

Context Menu. 

 

 

  

Customize Toolbar Dialog Box 

Invoke Context 

Menu by right 

clicking on the top 

of Toolbar 

Toolbar can be edited in 

Customize 

Show/Hide 

Check Box 

Reset 
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midas FEA offers various Selection methods and Work Window handling 

capabilities to effectively generate a model.  

 

 

3.3.1 Selection 

 

The Selection functions are extremely important and indispensable for the 

overall task of generating a model. midas FEA provides various selection 

methods so that the user can handle any complex model effectively in any 

situation.
 

 

      All selection methods are controlled from Selection Toolbar.  

 

 

 

 

 

 

 

 

 

 

 

 

Organization of midas FEA’s Selection Toolbar 

 

 

 

 

 

 

 

In order to 

understand all the 

selection functions, 

the user must 

become familiar with 

the geometry 

concept thoroughly. 

If you are unfamiliar 

with this concept 

yet, please review 

Chapter 2.1.2 

Modeling Process of 

midas FEA. 

Select / Unselect Mode 

Selection Filter 

Selection Method 

3.3 Selection and Manipulation of Work Window 
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 Select (0) Add to selection. 

 Unselect (0) Remove from selection. 

 Unselect All Unselect all the selected entities. 

 Include Intersected 

(Ctrl) 

Select all the entities that are contained inside the 

selecting area as well as the entities intersecting 

the defined boundaries. 

 

 

 

Pick / Window (1) 

Select entities by clicking the mouse once each 

time. Or select the entities in a rectangular 

bounding area defined by dragging the mouse 

cursor. 

 Circle (2) 
Select all the entities in a circular bounding area 

defined by dragging the mouse cursor. 

 

Polygon (3) 

Select entities by successively clicking the 

corners of a polygon containing the relevant 

entities with the mouse cursor. 

 Polyline (4) 
Select entities by crossing a series of lines that 

intersect the desired entities with the mouse cursor. 

 Query Pick (5) 
Select entity from the list of the entities, which are 

detected at the mouse click on the Work Window. 

 Displayed 
Select all the entities, which are currently shown 

in the Work Window. 

 ID 
Select the node(s) or the element(s) by entering 

its Node ID or Element ID. 

 

 

When the user brings the mouse pointer above a desired entity, it will 

become highlighted with a sky blue edge. Therefore, the user can check in 

advance whether or not the selection will be made correctly. Once the entity is 

selected, the boundary color will be changed to pink. 

 

 Select  

It invokes the Select Mode to select entities. 

The user can switch to the unselect mode by typing “0” on the keyboard or by 

pressing the middle button of the mouse. 

 

The parenthesis 

indicates the 

shortcut key for each 

selection method. 

This works only 

when the focus is on 

the Work Window. 
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 Unselect  

It invokes the Unselect Mode to unselect the selected entities. 

The user can switch to the select mode by typing “0” on the keyboard or by 

pressing the middle button of the mouse. 

 

 Unselect All 

This unselects all the selected entities. 

Double clicking the mouse scroll button also executes the function.


 

 

 Include Intersected 

When entities are selected with Window, Circle or Polygon, it selects all the 

entities that are contained inside the selection area, as well as the entities 

intersecting the boundaries of the area.


 

 

 

 

 

 

 

 

 

 

 

 

The user can toggle the Include Intersected Mode on and off by pressing the Ctrl 

key while dragging the selection area. 

 

 Pick / Window 

Using the Pick Select, desired entities can be selected by clicking the mouse 

once each time. The Window Select feature can be affected by dragging the 

mouse from one corner to the other. 

 

 Pick Select 

Select desired entities by clicking the mouse once each time. To unselect 

the selected entities, click them once again in the Select Mode. 

 

 

While operating the 

Include Intersected 

Mode, the selection 

boundary is drawn in 

dotted lines. 

Use caution while 

operating Unselect 

All. Depending on 

the speed of double 

clicking the mouse, 

the user may 

inadvertently switch 

between the select / 

unselect modes.  

A 

C 

B 

Window Selection (Include Intersected: Off) 

 Selection to be made: Only A 

Window Selection (Include Intersected: On) 

 Selection to be made: A & B 

A 

C 

B 
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 Window Select 

Click the diagonal corners


 of a window area containing desired entities 

with the mouse cursor and select or unselect the desired entities completely 

contained within the rectangular window. Press ESC to cancel while defining 

the window area. 

 

Enter the “1” key to switch to the Pick/Window Selection method during the 

modeling process. 

 

 Circle 

Select desired entities that are contained in a circular bounding area. 

The circular area is defined by clicking the center point and dragging out to a 

desired radius. Press ESC to cancel while defining the circular area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the “2” key to switch to the Circle Selection method during the modeling 

process. 

 

 Polygon 

Select or unselect desired entities by successively clicking the corners of a 

polygon containing the relevant entities with the mouse cursor. When clicking the 

final corner, double-click the mouse to end. Press ESC to cancel while defining 

the polygon. 

 

 

The direction of 

dragging a selection 

window is not 

important in midas 

FEA. The inclusion 

of the entities 

intersected by the 

window boundary is 

controlled by the 

Include Intersected 

Mode. 

Example of Applying a Boundary Condition using Circle Selection 

After clicking the 

center, drag out the 

mouse to define the 

selection area. 
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Enter the “3” key to switch to the Polygon selection method during the modeling 

process. 

 

 Polyline  

Select or unselect entities by drawing a series of lines containing the desired 

entities with the mouse cursor in the Model Window. When clicking the final point 

of the last line, double click the mouse to end. Press ESC to cancel while defining 

the polyline. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the “4” key to switch to the Polyline selection method during the modeling 

process. 

Example of Selecting Faces Using the Polyline Selection 

After successively clicking 

the corners of a polygon, 

double-click the mouse at 

the final corner. 

 

After creating a series of 

lines, double click the 

mouse to complete. 
. 
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 Query Pick  

Select or unselect desired entities from the list of all the entities, which are 

detected at the mouse click location. Going down the list, each entity on the list 

will be highlighted. Click OK for the desired entity to select. 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the “5” key to switch to the Query Pick Selection method during the 

modeling process. 

 

 Displayed 

Select or unselect all the entities shown in the Work Window.


 

Simply click the Displayed icon from the Selection Toolbar.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the desired entity 

is selected, press OK 

button to complete the 

selection. 

Example of Selecting a Solid Using the Query Pick Selection 

When Work Window 

is set to Zoom All, 

the Displayed 

selection will work 

identically as the 

Select All command. 
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 ID 

In the node and element selection mode, the user directly enters the Node or 

Element ID(s) to select desired entities. The user can distinguish the Node and 

Element Selection Mode by Selection Filter. This mode is only active for the node 

and element manipulation functions. When the ID selection method is on, the ID 

Selection dialog box appears on the Work Window. The detailed selection 

procedure is explained below. 

 

1. Enter the ID(s) of either Node or Element in the Dialog Box to make a 

selection. 

 

2. If nodes and elements are selected by different selection methods, the ID(s) 

of the selected entities will appear on the dialog box. The user can modify 

the list of the selection to complete.


  

 

 

Example of the Displayed 

Selection at “Zoom All” view 

Simply click the Displayed 

Select Icon 

클릭하면 된다. 

The Selection Filter 

will be explained in 

the next section in 

detail. 

The ID Selection 

Dialog box behaves 

like an intermediary 

between the 

selection manager 

and the Command 

Dialog. 
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The ID Selection dialog box consists of the following buttons. 

 

Add 
Add the newly entered node(s) or element(s) ID(s) to the 

selection. 

Replace 
Unselect the existing selection, and select the newly entered 

ID(s) for nodes or elements. 

Clear Clear the list in the ID selection dialog box.


 

Close Close the ID selection dialog box. 

 

 

The Selection Filter enables the user to select only by the specified entity type. 

Depending on the working mode and the active command, the Selection Filter 

changes its form, and the user can choose the entity type within the specially 

customized Selection Filter. The working mode in terms of the Selection Filter is 

basically distinguished by whether or not a command is invoked. 

 

 Neutral Mode 

The neutral mode is when the user has not called a command yet with the 

Selection Filter set to the default. In the neutral mode, the user only can select 

Datum


, Shapes and Mesh Sets.
 The sub-Shape of a geometric entity and the 

individual nodes and elements cannot be selected. 

Even after the user 

clears the Selection 

Dialog Box, the 

previously selected 

entities still remain 

selected. 

 The ID selection is 

convenient for 

selecting specific 

elements when 

multiple elements 

are located at the 

same location. 

Example of Selecting a Specific Node within 

The selected nodes are automatically 

listed in the dialog box. 

IDs can be directly typed in, and 

selected IDs listed in the selection 

dialog can be modified. 

Interface Element (Duplicated).


 

 

Command Dialog Box 

The Datum 

represents reference 

points, lines, and 

planes. 
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 Command Mode 

The Command mode is activated when the user has called a specific command, 

and the Selection Filter has formed with the relevant type of the function.


 The 

user can select any desired type including the sub-Shape and the individual node 

and element depending on the type of the command. 

 

 

 

 

 

 

Selection 

Filter 

Working Mode Selected Entity 

Shape 
Neutral Mode 2  (F-1, E-1) 

Command Mode 2  (F-1, E-1) 

Edge 
Neutral Mode 1  (E-1) 

Command Mode 5  (E-1, E-a, E-b, E-c, E-d) 
 

             Difference in selected entities between the Neutral Mode and the Command Mode 

  

Shape Type 

F-1 Face (4 Sub-edges) 

E-1 Edge 

It is recommended 

that the Selection 

Filter be set to the 

Shape in the Neutral 

Mode. 

The Selection Filter 

changes its form by 

the relevant 

command. Ensure to 

check the Selection 

Filter before 

proceeding. 

F-1 

E-a 

E-d 
E-b 

E-c 

E-1 
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Although the same type of entity has been specified in the Selection 

Filter, the selected entities turn out differently depending on the current working 

mode. The difference occurs because only the independent geometric entity 

(Shape) is allowed in the selection in the Neutral Mode. This concept may seem 

complicated at first, but it becomes highly beneficial when it comes down to 

advanced modeling applications. 

 

      The following example explains where the selection restriction in the 

Neutral Mode can be effectively used. A 3-dimensional face is created by 

connecting 8 curved edges. 

 

 

 

 

 

 

 

 

 

 

 

Since the original eight edges are no longer needed, they should be 

either deleted or hidden. Let us carefully look into either case, when the Sub-

shape selection is restricted or when it is allowed.  

 

 If all geometric entities including sub-Shapes are allowed in the 

selection, 

1. With “Shape” in the Selection Filter 

A total of 9 Shapes (1 Face and 8 Edges) are selected. 

 

2. With “Edge” in the Selection Filter


 

A total of 12 Edges are selected. 4 of them belong to the Face, and they 

cannot be separately treated by the program. 

 

 

Why is there such a difference in selection between the working modes? 

Shape (8 Edges) Shape (1 Face, 8 Edges)  

Edge (Total 12, 8 edges for Shape and 4 edges for Face) 

Each edge can be 

picked manually one 

by one, but it still 

causes difficulties 

since some edges 

are duplicated at the 

same location. 
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 If only the Shape is allowed in the selection, 

By having the Selection Filter for Edge, only the 8 unnecessary edges will be 

selected, which can be deleted or hidden all together.
 

 

 

In order to perform such an operation easily, midas FEA allows only the 

Shape to be selected in the Neutral Mode. 

 

       In the Command Mode where modeling processes are mostly carried 

out, both the Shape and the Sub-shape can be used freely


. Therefore, in 

actual operation, the selection difference between the Neutral Mode and the 

Command Mode does not create any problems, and in fact it helps during 

complex modeling. 

 

  

In actual modeling, 

such an operation 

can be also 

performed easily by 

the use of the Works 

Tree. 

Some commands 

restrict the sub-

Shape in selection 

due to a similar 

reason as in this 

example. 
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The general components of the Selection Filter are shown in the 

following table. 

 

 

Selection Filter Subjected Entity 

Datum Axis (A) 

Select Datum Axis. 

 To define direction (Translate/Extrude/Project), revolution 

axis, etc. 

Datum Plane (P) 
Select Datum Plane. 

 To define the plane to project, to divide, and to mirror. 

Geometry 
<1>

 

Shape (S) Select Shape. 

Solid (L) Select Solid. 

Shell (H) Select Shell. 

Face (F) Select Face. 

Wire (W) Select Wire. 

Edge (E) Select Edge. 

Vertex (V) Select Vertex. 

Mesh 

Mesh (M) 

Select Mesh Set. 

 To select Mesh Set itself or to select nodes and/or 

elements that are included in the Mesh Set. 

Node 
<2>

 Select Node. 

Element 
<2>

 Select Element. 

Node/Element 
<3>

 

Select Node and Element at the same time. 

 To include or exclude nodes and elements in the Mesh Set. 

Element-Face 
<4>

 

Select a 3D element face. 

 To apply Face Pressure Load on a 3D element face. 

Element-Edge 
<4>

 

Select a 2D element edge. 

 To apply Edge Pressure Load on a 2D element edge. 

 

<1> The sub-Shape of geometric entities will not be selected in the Neutral Mode. 

<2> Only applicable for the Node/Element modifying functions. 

<3> Only applicable for the “Incl/Excl” function in the Mesh Set Menu. 

<4> Only applicable for the Load and Boundary Condition functions. 

 

 

 

In the table, the 

letters in the 

parentheses 

represent the 

shortcut keys for the 

Selection Filter 

components. 

The shortcut keys 

work only when the 

focus is on the WorK 

Window. 
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The specified type in the Selection Filter will be displayed at the Cursor 

Tip on the screen. 

 

 

 

 

 

 

 

 

 

 

Since all the sub-Shapes can be selected in the Command Mode, the 

number of selectable entities increases tremendously for lower level entities. 

Therefore, it is very difficult to select a proper entity among many duplicated 

items by using the mouse cursor. In order to alleviate such a problem, midas 

FEA provides the following functions: 

 

1. When the selection method is on “Pick”, the highlighted entity at the mouse 

cursor can be alternated by pressing the Top/Down arrows of the 

keyboard.


 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The user can control 

whether or not to 

display the type at 

the Cursor Tip in the 

Display Option (View 

> Display Option). 

This method works 

only in the Command 

Mode. 

Specifying the Selection Filter 

Example of Cursor 

Tip 

  

  The detected shape 

alternates as the 

Top/Down arrows on the 

keyboard are pressed. 

Selecting a face in the Command Mode 
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2. The Query Pick selection can help the user to properly select a desired 

entity. 

The user can carefully check the selection from the list of the entities, which 

are detected at the mouse position. 

 

When any function related to the selection does not operate properly


, 

check the following items for troubleshooting:  

 

1. Check whether or not the selection mode is the Select Mode or the Unselect 

Mode. 

 

2. Ensure that the entity type is correctly specified in the Selection Filter. 

 

3. Try again at a different mouse position. 

 

4. Change the selection sensitivity (allowable tolerance).


  

The selection sensitivity can be modified in File > Preference Menu.  

 

Most cases will be resolved by (1)~(3), and (4) must be used only in 

special situations. 

 

The geometric characteristic and topology can be also implemented in 

the modeling process in midas FEA. Therefore, the geometric entities, which 

include special characteristics such as direction and plane can be selected. 

 

       The following examples are most frequently used cases for utilizing the 

geometric characteristic and topology in midas FEA. 

 

 Define Direction or Revolution Axis 

When executing commands such as Translate, Extrude, Project, Rotate and 

Revolve, the user must define a direction or revolution axis to complete the 

operation. In midas FEA, the direction and the revolution axis can be defined by 

using various entities, which relate to relevant characteristics. 

 

The entities that can be used to define directions and revolution axes are listed in 

the following table: 

 

If the selection 

sensitivity is set very 

high, too many objects 

can be detected. This 

tolerance also affects 

the snap tolerance. 

Therefore, use caution 

when changing the 

selection sensitivity.  

Most problems are 

associated with the 

Select / Unselect 

Mode or the 

Selection Filter. 
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Allowed Entity Geometric Characteristic Selection 

Filter 

Datum Axis 
<1>

 The direction of Datum Axis Datum Axis 

Datum Plane 

The normal direction of Datum Plane 

 

 

Datum Plane 

Edge (Straight 

Line) 

The direction of a straight line 
Edge 

Edge (Circle/Arc) 

The normal direction of a plane 

defined by a circle or an arc. 

 

 

Edge 

Face (Plane Face) 

The normal direction of a plane face 

 

 

Face 

Face (Revolved 

Face) 

The central axis of a revolved face 

(cylinder, etc) 

 

 

Face 

2 Point Vector A user-defined 2 point vector N/A 

Normal of Profile 
<2>

 

The direction normal to an executing 

object (planar entity) 
N/A 

 

<1> The Datum Axis is set as default in the Selection Filter for defining the 

direction and the revolution axis. 

<2> Its use is limited to some special functions such as Extrude and Local 

Prism. 

 

 

 

 

 

 

 
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As shown in the above examples, any direction and rotational axis can 

be easily defined by using the unique characteristic of a geometric entity. In 

addition, midas FEA provides various snap functions to define a 2 point vector 

and a 3 point plane, which can be very effective during the process of complex 

modeling. 

 

To create a pipe from a circle, the extrusion direction can be defined by the normal 

direction of a plane where the circle is located. 

Direction by Circle 

To create stiffeners in 3D space, 2D edges are extruded in the direction of an 

existing straight line. 

Direction by Straight Line 

Rotational Axis by Arc 

To copy the pipe by rotating about an axis, it is convenient to select the center arc 

as the revolution axis. (The revolved body face can be also selected.) 
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Grid Vertex End Middle Ortho Center Quadrant Intersection Node All-Off 

           The Snap Toolbar of midas FEA 

 

 Select by Means of Topological Relationship of Geometry Shape 

Due to the topological concept in midas FEA, sub-Shapes can be selected by 

using higher level geometry. In other words, by selecting a higher level entity, the 

user can select all of its sub-Shapes at once.  

 

 

 

 

 

 

 

 

 

 

 

 

 

For example, in the above case, each edge will be selected separately if the 

Selection Filter is set to Edge. However, by setting the Selection Filter to Face, 

the user can select the four sub-Edges at once. The use of a higher level entity is 

thus recommended to select all of its sub-Shapes. 

 

 Select Node and Element 

Similar to the geometry selection, after setting the Selection Filter to Mesh, the 

user can select Mesh Sets from the Work Window or the Works Tree. Since 

nodes and elements are included in a Mesh Set, all of them will be selected 

together at the same time. If mesh is generated on the geometry, its nodes and 

elements can be selected by the geometry unit such as Face and Edge.


  

 

 

 

Structure of Selection Filter 

Mesh Size Control along Edge 

(Ready to Select Edges) 

F (Face) 

E1 

E3 

   E2 E4 

For selection by 

Geometry, it must be 

shown on the screen. 
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 Selecting Nodes or Element-Faces Using Feature Angle  

For maximum work efficiency in applying load and boundary conditions, midas 

FEA offers additional selecting tools, which are customized especially for defining 

load and boundary conditions. The most frequently used tools among them are 

the Free Face selection in 3D mesh and the Free Edge selection in 2D mesh.


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This selection method 

does not use 

geometry 

relationships. 

Therefore, it is useful 

when mesh is 

generated manually 

without geometric 

shapes. 

Example of Selecting Nodes which belong to 6 Top Faces  

Example of Selecting Top Face Nodes (Free Face Node in 3D Mesh) 

 

From this seed node, the 

free face can be found 

within the specified 

Feature Angle. 

 

Select relevant elements  

(Possible to select all) 

 

Free face nodes are found 

by spreading out from the 

seed node within the 

Feature Angle. 
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 Other Useful Selection Tools 

When selecting nodes and elements, the user can choose a specific material or 

property from Pre-Works Tree. It detects all the nodes or elements to which the 

selected material or property is assigned.  

 

In a similar way, selecting a load or boundary condition from Pre-Works 

Tree will make the selection of relevant nodes and elements as well. This 

feature is very useful when modifying or deleting previously assigned load and 

boundary conditions.  
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3.3.2 View Manipulation Functions 

 

 

All the View Manipulation functions of midas FEA assist the user to 

accurately grasp the three-dimensional views of the model input state and the 

analysis and results through diverse view angles and points. 

 

Most of the View Manipulation functions are available in Icon Menu of the View 

Toolbar. 

 

 

 

 

 

 

The Organization of the View Toolbar 
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 Reset View Initialize the viewpoint and the screen size to default. 

 Zoom All Fit the model to the screen size by scaling up/down. 

 Zoom 

Window 

Assign a desired size of the window by dragging a corner 

of the window with the mouse. 

 Iso View Display the model in a three-dimensional space. 

 Front View Display the model as viewed from the –Y direction. 

 Rear View Display the model as viewed from the +Y direction. 

 Top View Display the model as viewed from the +Z direction. 

 Bottom View Display the model as viewed from the –Z direction. 

 Left View Display the model as viewed from the –X direction. 

 Right View Display the model as viewed from the +X direction. 

 

Normal View 

Display the model as viewed from the positive normal 

direction of the Work Plane. 

(The +X-axis of WP is displayed on the right, and –Y-axis 

is displayed at the top.) 

 Rotate Left Rotate the model to the left (clockwise about Z-axis). 

 
Rotate Right 

Rotate the model to the right (counterclockwise about Z-

axis). 

 Rotate Up Rotate the model upward from the horizontal plane. 

 Rotate Down Rotate the model downward from the horizontal plane. 

 Dynamic 

Zoom 

By dragging the mouse, zoom in/out the model view. 

 Dynamic Pan By dragging the mouse, move the model view. 

 Dynamic 

Rotate 

By dragging the mouse, rotate the model view. 

The rotational angle 

at each click of the 

Icon Menu can be 

modified in the 

Display Option. 

(View > Display 

Option) 
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The most frequently used view control functions are the Dynamic View 

Manipulations. 

 

 Dynamic Zoom (    , Ctrl+LB) 

After clicking the Dynamic Zoom Icon, drag the mouse in the Work Window to 

zoom in/out the model view. Pressing the left button of the mouse and dragging 

the mouse downward or to the left reduces the window, and dragging the mouse 

upward or to the right magnifies the window. To continuously zoom in/out, drag 

the mouse around while pressing down both the “Ctrl” key and the mouse left 

button. 

 

 Dynamic Pan (    , Ctrl+MB) 

After clicking the Dynamic Pan Icon, drag the mouse in the Work Window, and the 

model will follow the course of the mouse. To continuously pan, drag the mouse 

around while pressing down both the “Ctrl” key and the mouse middle button. 

 

 Dynamic Rotate (    , Ctrl+RB) 

After clicking the Dynamic Rotate Icon, drag the mouse in the Work Window, and 

the mouse direction will rotate the model. To continuously rotate, drag the mouse 

around while pressing down both the “Ctrl” key and the mouse right button. 

 

Rear View 

Front View 
Right View 

Left View Top View 

Bottom View 

Isometric View 
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The Dynamic Rotate behaves differently depending on the location where the 

mouse drag starts. If the user drags the mouse from the left/right boundaries


 of 

the Work Window, the model will rotate 2-dimensionally on the current view plane. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Drag from the 

left/right boundary 

for 2D rotation. 

Dynamic Rotate has different functionality depending on the dragging position. 

It should be within a 

10% range of the 

Work Window 

boundaries. 
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3.3.3 Model Representation 

 

The Model Representation functions of midas FEA present the model in 

diverse displays and views. These functions help the user grasp the input state 

of the model and manipulate the model freely as desired. 

 

 Display Mode of Geometry 

The display mode of geometry can be specified to an individual shape. To modify 

the graphical display, the user selects the desired shape(s)
 

 first and sets the 

Display Mode Menu, which can be found in the Context Menu. 

 

 

 

 

 

 

 

 

 

 

 

A geometric model can be displayed in 4 different modes. 

 

1. Wireframe 

It only displays the boundary edges of the shape. 

 

2. Shading 

It only displays the exterior faces of the shape. 

 

3. Shading with Edge 

It displays both the boundary edges and the exterior faces. 

 

4. Bounding Box 

Instead of displaying the actual shape, it displays a bounding box. When the 

user moves the mouse cursor into the bounding box, the geometric entity 

will be shown in the Wireframe Display. 

The object entity 

must be “Shape”, so 

that multiple entities 

can be modified 

together. 

 Changing the Display Mode in the Context Menu 
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       In addition, midas FEA provides the Transparency option in the 

Shading or Shading with Edge display thereby allowing the user to see 

through the interior of the geometric shape. The Transparency option can be 

found in the Context Menu once the object shape is selected. In the 

Transparency dialog box, the transparency level can be adjusted. To remove the 

Transparency from the shape, set it to 0 or click the Reset button. 

  

Bounding Box 

Wireframe Shading Shading with Edge 
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The Display Mode can be applied differently to each individual Shape. 

Therefore, it can be effectively used to model complex models, which have 

numerous geometrical shapes requiring different display identities. 

 

 Display Mode of Mesh 

The display mode of mesh can be specified to each individual Mesh Set. Similar 

to the display mode of geometry, the user must select a desired Mesh Set before 

selecting the Display Mode menu in the Context Menu.  

 

      The Mesh Set can be displayed in the following three different ways: 

 

1. Wireframe 

It hides the faces of all the elements in the Mesh Set and only displays the 

element edges. 

 

Example of Transparency Display 

Example showing the Interior Solids and Tendons by Transparency 
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2. Shading 

It shows both the edges and faces of the elements in the Mesh Set. 

 

3. Feature Edge 

It displays a Mesh Set with the Feature Edge. The Feature Edge represents 

the edge where the angle between the two connected free faces is greater 

than the specified angle


. In this mode, the user can visually verify the 

shapes of internally hidden Mesh Sets. 

 

 

 

 

 

 

 

4. Free-Face Wireframe 

It shows the free faces of a Mesh Set in Wireframe. All internal elements will 

be hidden.   

 

 

    

 

 

 

 

 

 

 

 

 

 

      Similar to the graphic display capabilities of geometry, the display option 

can be applied to individual mesh sets. 

 

      The user can apply the Shrink option to each Mesh Set to display its 

elements in proportionally reduced sizes. 

 

Its default angle is 30 

degrees, and it can 

be adjusted in the 

Display Option (View 

> Display Option). 

Element Face (Free Face) 

Element Edge 

 

Feature Edge if  is 

greater than a 

specified angle. The default display 

mode of Mesh Set 

can be set in the 

Display Option 

(View > Display 

Option). 

Example of Wireframe Display Example showing Tendon Locations 

by Displaying Solid Mesh by Feature Edge 
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 Perspective Mode  

The Perspective Mode displays the model in a perspective 3-dimensional view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Perspective 

Ratio can be 

adjusted in the 

Display Option 

(View > Display 

Option).  

In the Perspective 

Mode, the Grid 

Snap cannot be 

used. 

Example of “Shrink” Display of a 2D Mesh Set 

Perspective Mode Parallel Mode 
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3.3.4 Data Input Command 

 

For convenience, midas FEA provides the following data entry options: 

 

1. Where several numerical data are entered consecutively in a data field, 

these data can be distinguished by a “,” (Comma) or a “  ” (Blank space). 

<Example> „333, 102, 101‟ or „333 102 101‟ 

 

2. Where the same length is repeated, the entry can be simplified by “number 

of repetition @ length” instead of repeating the same number. 

<Example> 20, 25, 22.3, 22.3, 22.3, 22.3, 22.3, 88  20, 25, 5@22.3, 88 

 

3. The keyboard may be used to enter selected data directly. The related node 

numbering or element numbering may be an arithmetic progression in series 

or the progression may be incremental. Then, the data entry can be 

simplified by “start number to (t) final number” or “start number to (t) final 

number by increment” 

< Example> 21, 22, … , 54, 55, 56  “21 to 56”, “21 t 56”  

< Example> 35, 40, 45, 50, 55, 60  “35 to 60 by 5”, “35 t 60 by 5”  

 

4. Numbers and mathematical expressions can be used in combination. The 

majority of the operators and parentheses applied in engineering 

computation can be used. 

<Example>   20  PI * 20 

<Example>  35 3 sin 30 2 cos30 sin 30     
 

       “35 + 3 * (sin(30) + 2 * SQRT(cos(30)+sin(30)))” 
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Built-in operators in midas FEA are as follows: 

 

Notation Content Remarks 

( Open parenthesis – 

) Close parenthesis – 

+ Addition – 

- Subtraction – 

* Multiplication – 

/ Division – 

PI  3.141592653589793 

SQRT  Ex.: 2  = SQRT(2) 

SIN Sine Unit: Degree 

COS Cosine Unit: Degree 

TAN Tangent Unit: Degree 

ASIN Arc Sine Ex.: sin
-1

(0.3)=ASIN(0.3) 

ACOS Arc Cosine 
Ex.: cos

-1
 

(0.3)=ACOS(0.3) 

ATAN Arc Tangent 
Ex.: tan

-1
 

(0.3)=ATAN(0.3) 

EXP Exponential function Ex.: e
0.3

 =EXP(0.3) 

SINH Hyperbolic Sine Ex.: sinh(1)=SINH(1) 

COSH Hyperbolic Cosine Ex.: cosh(1)=COSH(1) 

COTAN Cosine/Sine Ex.: cotan(1)=COTAN(1) 

LN Natural Logarithm – 

LOG Common Logarithm – 

 Operators accept the mixed use of capital and lowercase letters. 

 As the operators are similar to that of an engineering calculator, the hierarchy of 

operations follows the rules of common mathematical operations. 

 



 

 

 

We Analyze and Design the Future 
We Analyze and Design the Future 

nalyze and Design the Future 

Ⅰ-3-71 

 

 
 

3.3.5 How to Use the On-line Manual 

 

 

When using midas FEA, pressing F1 key or clicking the Help menu allows 

access to the On-line Manual. 

 

Every category of help is connected to related keywords by hyperlink, 

and all the detailed explanations and information in connection with the keyword 

may be obtained. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

        On-line Manual of midas FEA 

 

A summary of the help contents and an index of the main keywords are 

arranged systematically in the On-line Manual of midas FEA. The user should 

read it as a reference in the order presented in the summary. Alternatively, the 

information regarding the desired item may be directly obtained using the 

Search function of the keywords. 


